"A photograph is a secret about a secret. The more it tells you the less you know.” —Diane Arbus

The following information is provided to assist you in the initial weeks of the class. Although much of this information is explained in detail in the textbook, it is advisable for you to print this information to have on hand when performing the tasks described. Many students find it useful to incase these sheets in clear plastic sleeves to keep them clean, particularly when working at the sinks and in the darkroom.

This is not a replacement for your textbook.
LOADING THE FILM INTO THE CAMERA

The steps shown here are for loading the Pentax K1000 camera. However the steps for all 35mm cameras are nearly the same. Follow all of these steps exactly and be aware of warnings that will save you sorrow later.

(1) **Pull UP on the rewind knob** on the left side of the camera. This will open up the back of the camera as you see in this photograph. Be sure you pull up far enough. If the back does not open it means you did not pull up far enough.

(2) Open up the box, take out the plastic container (keep this for storage) and remove the roll of film with the leader sticking out.

(3) Place the film into the left side of the camera. IF the film does not slip easily into the open area pull UP on the rewind knob again to make space for the film.

Push the rewind knob back after the film is in the pocket. IF it does not go all the way in twist it until it seats into the film container all the way. The leader is pulled to the other side of the camera and is ready to place in the take up spool. On an auto load camera simply pull the leader until it reaches the red dot and then seat the film holes on the little teeth in the take up mechanism.

(4) Insert the narrow end of the film leader into the take up spool slot or opening. It will go in a short distance and then STOP. It has hit a spring like mechanism that it must be PUSHED past. Hold the spool steady with one hand and PUSH the film in deeper until it either goes all the way inside the spool or it comes out the other side. **This is the most common error.** IF it is not in far enough it will pop off when taking pictures and you will get nothing on your film and waste the $ it cost you.

(5) Push the shutter release if needed and then use the film advance to wind the film until the entire leader is wound around the take up spool like you see here. Let the camera do the winding for it will do it backwards from what seems logical.
Make sure the teeth are properly placed in the holes on the film on BOTH sides of the film. Next use the rewind knob to take up the slack - to tighten the film in the camera. Turn the knob in the direction of the arrow until the film slack is taken up. Do not pull so hard that you tear the film or begin to pull it off the take up spool.

(6) Close the back of the camera and immediately take THREE pictures. IF the film has been loaded properly the rewind knob will TURN every time you crank the film advance lever. IF it does not then check to be sure the slack was taken up. If it was and the knob still does not turn then open up the back of the camera and check to be sure the film did not pop out of the take up spool. The film advance lever is on the right side of the camera and will not advance the film until the shutter has been released. Be sure to take at least 2 pictures. This will remove the exposed film from the leader and put fresh film in front of the shutter ready for your first photo.

(7) Set the ASA or ISO number on the shutter speed dial to 400 (or 100). This number will be different for each type of film. Next set the shutter speed to 1000 if it is a nice sunny day or 250 if it is overcast. This will be close to our needed shutter speed and will make exposure easier.

(8) Set the aperture on the ring closest to body of the camera (on the lens - it has numbers like 2, 4, 5.6, 8, 11 and 16) to an aperture of f16. This will let in the least light and is a good starting point for setting up exposure.

(9) When you are finished taking pictures DO NOT open up the back of the camera until you have rewound the film back into the cartridge. To rewind the film you first MUST release the film by pushing the little button on the bottom of the camera. Pushing this in allows the film take up spool to go backwards. Failure to do this will cause the film to rip and be destroyed. Once the button is in you may turn the rewind knob in the direction of the
There will be roughly 26 complete turns for a roll of film. When the film is back into the cartridge you will hear a clicking sound and the rewind will get easier to turn. Then you may open up the back and pull out the film. Put the film in the storage container that was in the original box. If you do not it will leak light into the opening and fog your film (turn it black). Always load and unload a camera in shade and never in direct sun for it will also cause light leaks and fog your film.

### Developing Time Based On Temperature Changes

Ideally, your film developer and other chemicals should all be used at 68°F. In reality, temperatures can vary widely unless you have an expensive fluid control system installed in your darkroom.

<table>
<thead>
<tr>
<th>Temperature</th>
<th>5:00</th>
<th>4:30</th>
<th>4:00</th>
<th>3:30</th>
<th>3:15</th>
<th>2:30</th>
<th>N/R</th>
<th>N/R</th>
</tr>
</thead>
<tbody>
<tr>
<td>64°</td>
<td>5:00</td>
<td>4:30</td>
<td>4:00</td>
<td>3:30</td>
<td>3:15</td>
<td>2:30</td>
<td></td>
<td></td>
</tr>
<tr>
<td>66°</td>
<td>5:30</td>
<td>5:00</td>
<td>4:30</td>
<td>4:00</td>
<td>3:15</td>
<td>2:30</td>
<td></td>
<td></td>
</tr>
<tr>
<td>68°</td>
<td>6:00</td>
<td>5:30</td>
<td>5:00</td>
<td>4:30</td>
<td>3:15</td>
<td>2:30</td>
<td>N/R</td>
<td>N/R</td>
</tr>
<tr>
<td>70°</td>
<td>6:30</td>
<td>6:00</td>
<td>5:30</td>
<td>5:00</td>
<td>3:15</td>
<td>2:30</td>
<td></td>
<td></td>
</tr>
<tr>
<td>72°</td>
<td>7:15</td>
<td>6:30</td>
<td>6:00</td>
<td>5:15</td>
<td>3:15</td>
<td>2:30</td>
<td></td>
<td></td>
</tr>
<tr>
<td>75°</td>
<td>8:00</td>
<td>7:15</td>
<td>6:30</td>
<td>5:15</td>
<td>3:15</td>
<td>2:30</td>
<td></td>
<td></td>
</tr>
<tr>
<td>77°</td>
<td>8:45</td>
<td>7:45</td>
<td>7:00</td>
<td>6:30</td>
<td>5:15</td>
<td>2:30</td>
<td>N/R</td>
<td>N/R</td>
</tr>
<tr>
<td>80°</td>
<td>9:15</td>
<td>8:15</td>
<td>7:30</td>
<td>6:45</td>
<td>5:15</td>
<td>2:30</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>9:45</td>
<td>8:45</td>
<td>8:00</td>
<td>7:15</td>
<td>5:30</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>10:30</td>
<td>9:30</td>
<td>8:30</td>
<td>7:45</td>
<td>6:30</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>11:15</td>
<td>10:00</td>
<td>9:00</td>
<td>8:00</td>
<td>7:15</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>11:45</td>
<td>10:30</td>
<td>9:30</td>
<td>8:15</td>
<td>6:15</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>12:30</td>
<td>11:15</td>
<td>10:00</td>
<td>9:00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
PROCESSING FILM

Plastic reels and tanks
1 reel = 15 ounces  2 reels = 24 ounces
Metal
1 reel = 14 ounces  2 reels = 28 ounces

Refer to the directions on your film for processing times! Open up the box, it is usually written on the inside.

STEPS
1. PREWET: pour 70° water into the tank for 1 minute
2. DEVELOP: D-76, mixed 1:1 at 70°, check the chart for times
   a. AGITATE: continually for the first 30 seconds, then 10 seconds every minute
   b. Discard into the tank when through
3. STOP BATH: use water at 70°, AGITATE for the first 30 seconds. (if using acetic acid, mix 1 part prepared stop to 9 parts water for use)
   a. Discard into tank
4. FIXER: straight from the storage tank, 70° for 7 minutes
   a. AGITATE: continually for the first 30 seconds, then 10 seconds every minute
   b. You need fix your film for only twice as long as it takes for the film to clear
   c. Pour back into the Fixer tank
5. WASH: in water at 70° for 2 minutes
   a. Fill & Dump Method: fill for 15 seconds, dump for 5 seconds, repeating 3 times each minute
   b. Discard into sink
6. FIXER REMOVER OR HYPO CLEAR: straight from the storage tank, 70° for 2 minutes
7. FINAL WASH: in water at 70° for 5 minutes
   a. Fill & Dump Method: same as above OR
   b. Use the reel washer in the sink
8. PHOTO-FLO: do not dump the last tank of water
   a. Add 3 drops of photo-flo per 16 ounce tank; Agitate the reels for 1 minute
   b. If Photo-Flo tank is available: drop reel in the tank for 1 minute
   c. Remove film from reel, use your fingers to squeegee the water off
   d. Hang up to dry in the film cabinet
9. CLEAN UP: rinse all reels, tanks and lids in hot water
   a. Do not wipe with darkroom towel, allow to air dry or blow-dry
**STEPS FOR PROCESSING A PRINT:**

1. Place the paper into the developer face up. Put it under quickly. Keep the developer in CONSTANT motion by lifting up the side of the tray and keeping the "wave" of developer in constant motion. A properly exposed print will appear in about 10 seconds and will have a deep rich black where the light hit and a clean white where it was protected after a full 60 seconds in the developer. RC paper requires 1- 1½ minutes. Fiber paper needs 2-3 minutes.

2. Place the developed print into the center tray of "stop bath" for 15-30 seconds. (FP 30 sec to 1 minute)

3. Place the rinsed print into the fixer. It will be safe to look at it under normal room light in about 60 seconds and finished fixing in 3-5 minutes. (FP 5-10 minutes) *

4. Take the fixed print to the print washer and wash it for 10 minutes. Then take it to the dryer.

Fiber Paper:
After step #3, place in water rinse for 5 min, in Fixer remover for 2-3 minutes. Then in Final wash for 20-30 minutes.

* Note: about half these times with a rapid fixer. Check with the lab assistant.

I. Materials Needed
   A. Grade #2 or variable contrast enlarging paper (no filters)
   B. Double weight glass or contact printing frame
   C. A roll of negatives in a clear type of negative preserver
   D. A piece of cardboard large enough to cover the entire sheet

II. Procedure
   A. Make a Test Strip
      1. Cut a piece of photographic paper 1 ½” x 8”
      2. Put enlarger ½ way up, about 18” from baseboard. (Note the number on the riser, you will need to remember this.)
      3. Place lens in enlarger (probably there already), put out of focus to maximum degree. Set at f/8
      4. Place your negatives in a sandwich between unexposed paper and glass. The emulsion (shiny side) of paper should face emulsion (dull side) of negatives. Keep negatives in preserver for entire process
      5. Give the paper an initial exposure of 8 seconds. Do this by setting your timer at 4 seconds and press the starter button twice.
      6. Expose again at 4 seconds, covering ½ of a frame with cardboard. Repeat moving cardboard ½ frame further each time. Keep track of how many times you expose.
      7. Develop for recommended time. After processing in the stop bath, fix for at least 1 minute, rinse strip and view under white light (out of the darkroom)
      8. Examine the strip carefully to determine at which step there is no longer a visible change in the clear edge of the film around the sprocket holes. The step where this first occurs is the Threshold of Black. (T.O.B.) How many seconds did it take to obtain the T.O.B.? Don’t forget the first 8 seconds!
         a. If you see a change in the Black to the very end, you may not have found T.O.B. Repeat the test using f/5.6
         b. If the first swatch is really black, and there are no sprocket holes visible, you have given the strip too much light. Repeat the test using f/11.
   B. Make a Contact Sheet
      1. Place a sheet of 8 x 10” printing paper, emulsion side up, at the base of the enlarger. Do not use an easel.
      2. Place the negatives emulsion side down in rows on the paper.
      3. Gently lower a clean sheet of glass over both to hold them flat
      4. Turn on the enlarger for the period of time you determined produced T.O.B.
      5. Process the contact sheet through the chemicals and dry for evaluation.
   C. Evaluation – under bright white light, go out of the darkroom!
      1. If your photographs look the way you want them in your T.O.B. contact sheet, then you correctly exposed and developed your film.
         a. If you do not change the height of the enlarger, the T.O.B. exposure will be the best print exposure for a perfectly exposed and developed negative.
         b. If you change the height of the enlarger, or the area of projection, then you still know that your negative will print on a variable contrast paper.
      2. If at the T.O.B. your pictures look too dark, then you underexposed and/or underdeveloped your film.
a. Flat: highlights look gray, tones not sufficiently separated – you probably underdeveloped your film. Place #3 or #4 contrast filter in the enlarger to see if you can get a print you are satisfied with.
3. If at the T.O.B. your pictures are too light, then you overexposed and/or overdeveloped your film
   a. Uniformly light print: overexposed. Print with more exposure
   b. Blocked highlights, white print: overdeveloped. Try contrast filter #1.

Troubleshooting
Different ISO films will produce different results.
Different papers will produce different results.
Use the same enlarger each time you work in the darkroom for uniform results.
Depleted chemicals, and sometimes fresh chemicals, might alter your results.
PHOTOGRAPHY 31 AB – COMPOSITION

Composition is the start of the photographic process on the creative side. On the technical side we start with light—which is the raw material for our image and work with the exposure controls.

Composition is the placement of elements within the restriction of the frame of the photo. On a 35mm camera this is a rectangle. On a Twin Lens camera it is a square. In either case, the frame is going to see LESS than our eyes, so the trick is to decide what to point the camera at. A photo has two main parts. First is the subject, which is what we take a photo of. Second is treatment, which is how that subject is arranged within the frame.

Perhaps the most important guide for composition is called the Rule of Thirds. When the frame is divided into three parts horizontally and vertically we get the arrangement shown here. The lines of intersection are ideal placement points for the dominant element in our photo….the part of the photo that attracts our attention. We call that the center of interest or subject. Each photo should have such a point….if there is nothing that attracts your attention then the photo does not communicate as well.

Subject placement can also be placed along one of the thirds to be effective. The horizon line should be placed on the thirds line and never in the center if it is visible. This is a photo example of Thirds….notice that the dot represents the part of the photo our eye comes to rest on…this part of the photo is in contrast in color and shape to the rest of the photo and thus attracts more attention.

Pay attention to lines in your photo. Lines can be actual lines from a road or fence, or from an arrangement of objects such as these cars. Lines that are horizontal or flat tend to be peaceful and reduce the excitement of a photo. Diagonal lines make a photo have a feeling of action or excitement. Many times a movie producer will tilt the reality of the scene by tilting the camera to throw the balance off and make a viewer feel the tension or action. Here we have the larger truck placed on the diagonal lines to attract attention. Notice how it was placed on the thirds.

CURVED lines also are important. ANY line in the photo adds to the composition feel, here we see curved lines made by the arms of the swimmer add to the feeling of peacefulness. Notice how the face is placed in the thirds line.
Another example of LINES, in this case we call them **leading lines**. The lines made by the freeway overpass draw our eye INTO the photo and off toward the ending point where the white dot was placed.

![Leading Lines](image)

The **motion** of our subject is where the composition meets the technical. Here we find the **shutter** controls motion on our photo. If the shutter is fast (like 500 or 1000) the motion is frozen and if it is long or slow like 60 or less the motion becomes a blur. Each has its effect on the final photo. The important part is that the photographer has decided in advance how the photo will look. Notice how the rule of thirds has been used on this photo also.

When the shutter is set to a fast speed like 250 - 500 - 1000 the camera is not getting much light - the aperture will then need to be set to a wider setting letting in more light in order to get an exposure. The result....less depth of field and a background that becomes less clear.

The final technical concern in composition is in the **background**. Is there an object that is right behind our subject that might look like it is MERGING or growing out of our subject? Is the background needed or not. Here we see two ways to do it - include it or simplify it.

The **aperture** controls the background, although most cameras will only show you the simplified view when you focus. NOW the aperture works with the shutter to control light and exposure.

Background is simplified or made less sharp by a wide-open aperture like f 2, f4 or f 5.6. Close pictures or a telephoto lens make the effect more dramatic. By setting our shutter to a high number the aperture is forced to a LOW number and depth is reduced. By putting our shutter to a LOW number the aperture is forced HIGH and depth is increased. The two controls work together.
ASSIGNMENT #9 – 5 points

Computer skills for photography: instruction and demo will be given in the use of digital skills important for photographers, including scanning negatives, and prints, understanding resolution, file types, naming files, and burning cd’s. You will use your previous projects as material to scan one negative and a print from that negative into the computer, save the files, print on an Epson Photo printer and burn the files on to a CD.

Supplies Needed: Flash Drive, High quality image CD’s, Epson Premium Photo Paper, luster preferred.

RESOLUTION

Resolution is measured in megapixels. The higher the megapixels, the sharper and more detailed the pictures, and the bigger you can enlarge them without losing the sharpness of the image. 3.1 megapixels and higher is usually considered sufficient for print-quality photos. Photos with a resolution of less than 3.1 megapixels are best viewed only on computers.

In computers, resolution is the number of pixels (individual points of color) contained on a display monitor, expressed in terms of the number of pixels on the horizontal axis and the number on the vertical axis. The sharpness of the image on a display depends on the resolution and the size of the monitor. The same pixel resolution will be sharper on a smaller monitor and gradually lose sharpness on larger monitors because the same number of pixels are being spread out over a larger number of inches.

FILE TYPES: JPEG, TIFF

JPEG (pronounced “jay-peg”) is a standardized image compression mechanism. JPEG stands for Joint Photographic Experts Group, the original name of the committee that wrote the standard. JPEG is designed for compressing either full-color or gray-scale digital images of “natural”, real-world scenes. It does not work very well on non-realistic images, such as cartoons or line drawings. Each time you open and close a JPEG image, quality is lost. Therefore it is best to use them for quick imaging only.

TIFF is an acronym for Tag( ged) Image File Format. It is one of the most popular and flexible of the current public domain raster file formats. TIFF images retain their characteristics, no matter how many times you open or close them. They are not
suitable for sending over the web; image software must be used to view them. If you wish to save an archive of images on a cd, use this format.

PHOTOSHOP

Adobe Photoshop is image manipulation software. LBCC has recently upgraded to version CS3. You will be taught very simple basic steps to bring your photographic negatives and images into the computer, and burning your assignments on to a CD.

------------------------

NAMING FILES

• No characters, no spaces i.e. vinci_4.jpg
• Use extension i.e. jpeg, tif, etc.
• File>Save As
  o Type a name for the file, make sure the extension box is checked
  o Choose a landing place for the file, a folder on the desktop or Flash drive
  o Choose either the tiff or jpeg option

SCANNING NEGATIVES & PRINTS

• Scan through Adobe Photoshop, very high resolution, i.e. 300 dpi at 8x10”
• Crop out unwanted borders using the scan software
• Save on to Flash Drive in a new folder called Assignment_9 as a tiff file
• Remove the Flash Drive by dragging it to the trash – DO NOT REMOVE IT WITHOUT THIS STEP

PHOTOSHOP PREFERENCES, rulers in inches

• Go to another computer, insert Flash Drive
• Open Adobe Photoshop
• Go to Photoshop icon>Preferences>Rulers & Guides
  o Make sure inches is selected, close the window
• Open the file you just created
  o Go to File>open, from the window select desktop, then find your flash drive, and the file you just scanned, double click it to open

Go To Image>Image Size

• Uncheck Resample Image, under Document Size, Resolution, change pixels/inch to 300.
• Recheck resample image, under Document Size, change the width/height to 4 x 3 inches, or as close as you can get.
• Save the image as a tiff in a folder, name the image
• Now you will save the identical file as a jpeg
  o File > Save As
  o Choose the same folder as the landing place
  o Choose JPEG as the format, click on high quality > Save
• Burn images on a CD
• Print one image on to Epson Photo paper

**Crop Tool in Photoshop**

• Go to View > Rulers
• Pulling guides from rulers
  o Place the cursor in the narrow ruler area, click and drag a guide where you want it, release the mouse
  o Use guides to assist in cropping

The *Crop* tool allows you to select an area of an image and discard everything outside this area. The tool is in the Photoshop Toolbox, on the left side. Although cropping reduces the dimensions of an image, it is not the same as resizing. Whereas resizing reduces or enlarges the entire image and everything in it, cropping does not alter the size of the image content at all.

• Select the crop tool in the toolbox.
• Select an area of the image to retain (just the same as making a normal selection).
• When you release the mouse button, the area to be retained is highlighted. This is what the new image will look like.
• You can move or transform the crop area by dragging the selection or the selection handles.
• Hit your **Enter** key to perform the crop.

**Burning CD**

• Insert a blank cd into the drive
• Name the cd on the desktop with your last name by clicking once on the cd icon, it will turn color allowing you to type your own text
• Drag and drop files holding the option key down to copy the files in to the CD
• Highlight the cd icon
  o File>burn disc
    ▪ Best, NOT quicker